Cash Register express
Point of Sale Solution for Retail

Getting Started Guide

Includes 10 Quick Steps To Ringing Up Your First Sale

pcAmerica
Retail and Restaurant Solutions
# Table of Contents

## CONFIGURING CASH REGISTER EXPRESS
- Registering Cash Register Express 1

## 10 STEPS TO GETTING STARTED

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Plug in the Equipment 2</td>
</tr>
<tr>
<td>2</td>
<td>Install and Start Cash Register Express 3</td>
</tr>
<tr>
<td>3</td>
<td>Add Your Employees into the System 6</td>
</tr>
<tr>
<td>4</td>
<td>Configure a Few Setup Options 7</td>
</tr>
<tr>
<td>5</td>
<td>Create Your Inventory Items 8</td>
</tr>
<tr>
<td>6</td>
<td>Configure Your Inventory and Function Buttons 9</td>
</tr>
<tr>
<td>7</td>
<td>Login to the System 10</td>
</tr>
<tr>
<td>8</td>
<td>Ring in Some Items 11</td>
</tr>
<tr>
<td>9</td>
<td>A Few Basic Every Day Functions 12</td>
</tr>
<tr>
<td>10</td>
<td>Cash – or Credit – Out the Transaction 13</td>
</tr>
</tbody>
</table>

## COMPUTER ESSENTIALS
- Overview and System Security 14 |
- Backing Up Your Database 15 |

## HARDWARE SETUP
- Installing Epson Receipt Printer 16 |
- Assigning a Printer 17 |
- Installing a Bar Code Blaster Printer 18 |
- Logic Controls Pole Display 21 |
- Credit Card Reader & Bar Code Scanner 22 |
- Cash Drawer 23 |
INSTALLING THE ELO TOUCH SCREEN
SCANNER SCALE AND VERIFONE PINPADS
WEIGHT AND DELI SCALES

CONFIGURING CASH REGISTER EXPRESS

CHANGING THE ADMINISTRATOR PASSWORD & ADMINISTRATOR SWIPE CARD
TAX RATES
CONFIGURE YOUR RECEIPT
PERSONALIZE COLORS AND PICTURES
CREDIT CARD PROCESSING
CONFIGURING MULTIPLE STATIONS
PRINTING BAR CODES
CHECK PROCESSING
SPEED TIPS FOR RETAIL STORES

COMMON RETAIL FUNCTIONS

SELECT A CUSTOMER
DELETE, DISCOUNT, QUAN CHANGE AND PRICE CHANGE
PURCHASE ORDERS
CREATING A PURCHASE ORDER
RECEIVING PURCHASE ORDERS
BACK ORDERS
VOID AN INVOICE/PULLBACK AN INVOICE
SELL AND REDEEM GIFT CARDS AND STORED VALUE CARDS
CLOCKING OUT AND CLOSING OUT A DAY

TRACKING YOUR CUSTOMERS

CUSTOMER MAINTENANCE SCREEN
ADDING AND MODIFYING CUSTOMERS
ACCOUNTS RECEIVABLE AND CUSTOMER LOYALTY

YOUR INVENTORY

INVENTORY MAINTENANCE – ADDING AND MODIFYING ITEMS
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>SALE AND SPECIAL PRICING</td>
<td>49</td>
</tr>
<tr>
<td>CATEGORIES AND DEPARTMENTS</td>
<td>50</td>
</tr>
<tr>
<td>INVENTORY TRACK EXPRESS</td>
<td>51</td>
</tr>
<tr>
<td>MASS TRANSFER &amp; RETURNED ITEMS</td>
<td>52</td>
</tr>
<tr>
<td>CHOICE ITEMS</td>
<td>53</td>
</tr>
<tr>
<td>COUPON ITEMS</td>
<td>54</td>
</tr>
<tr>
<td>SETTING UP RETAIL ITEMS WITH NO BARCODE</td>
<td>55</td>
</tr>
<tr>
<td>tracking your employees</td>
<td>56</td>
</tr>
<tr>
<td>employee maintenance – adding &amp; modifying employees</td>
<td>56</td>
</tr>
<tr>
<td>employee security and exceptions tracking</td>
<td>57</td>
</tr>
<tr>
<td>job codes, time clock, hours &amp; wages</td>
<td>58</td>
</tr>
<tr>
<td>reporting</td>
<td>59</td>
</tr>
<tr>
<td>how to use the reporting screen</td>
<td>59</td>
</tr>
<tr>
<td>listing of the most useful reports</td>
<td>60</td>
</tr>
<tr>
<td>host module – connecting multiple stores</td>
<td>61</td>
</tr>
<tr>
<td>getting started</td>
<td>61</td>
</tr>
<tr>
<td>before you begin</td>
<td>61</td>
</tr>
<tr>
<td>about virtual private networks</td>
<td>61</td>
</tr>
<tr>
<td>configuring your system to accept connections</td>
<td>62</td>
</tr>
<tr>
<td>setting up your corporate database</td>
<td>65</td>
</tr>
<tr>
<td>common areas of the host module</td>
<td>67</td>
</tr>
<tr>
<td>setup</td>
<td>70</td>
</tr>
<tr>
<td>store setup</td>
<td>71</td>
</tr>
<tr>
<td>setup tax rates</td>
<td>72</td>
</tr>
<tr>
<td>change admin passwords</td>
<td>73</td>
</tr>
<tr>
<td>employee maintenance</td>
<td>74</td>
</tr>
<tr>
<td>monitoring</td>
<td>75</td>
</tr>
<tr>
<td>the monitoring screen</td>
<td>75</td>
</tr>
<tr>
<td>navigating the reporting screen</td>
<td>76</td>
</tr>
<tr>
<td>control</td>
<td>78</td>
</tr>
<tr>
<td>category maintenance</td>
<td>79</td>
</tr>
</tbody>
</table>
VENDOR MAINTENANCE 80
DEPARTMENT MAINTENANCE 81
GLOBAL PRICE CHANGES 82
INVENTORY MAINTENANCE 83
ITEM PROPERTIES 83
STYLES MATRIX 83
COOPERATION 84
CUSTOMER MAINTENANCE 85
LOYALTY PLANS AND LOYALTY INCENTIVES 85

HELP AND TECHNICAL SUPPORT 86

TRAINING SESSIONS AND CONTACTING TECHNICAL SUPPORT 86
Your copy of Cash Register Express must be registered before use. To register your software, choose Register from the Register menu in the Login Screen. Cash Register Express will prompt you for your activation number; enter the serial number on the side of your CRE box.

After entering your activation number, Cash Register Express will access the pcAmerica registration server over the internet to register your software.

**NOTE:** The registration process requires an active internet connection. If you do not have an internet connection, please contact your pcAmerica sales representative to manually register your software.
The first step of setting up your point of sale system is plugging in the equipment. The diagram below shows you where each device plugs in. Some of the devices require ‘hardware drivers’ which is what your computer uses to talk to each piece of equipment. Instructions of how to install these drivers are included below and also inside of the built-in F1 Help Section.

Some of the drivers may be installed with Cash Register Express. For instructions on installing additional drivers, refer to the ‘Hardware and Driver Installation’ section. We recommend you read the driver installation pages below for both the Logic Controls pole display and the ELO Touch Screen before plugging them in – it may be easier to install these two drivers immediately upon plugging the devices in!

**Note:** These are the most common connection arrangements. Depending on the equipment you purchased, your connection arrangements will vary.
Below are instructions on installing Cash Register Express and starting it for the first time. You must be logged onto your computer as an Administrator with full access rights in order to properly install Cash Register Express.

If you have multiple stations within your restaurant, it is very important that you install the server first! We also recommend you read the Configure Multiple Stations section later in this manual.

If you have multiple restaurants communicating to a corporate office, it is recommended you sign up for a pcAmerica training session to ensure you fully understand the process.

1. Insert the Cash Register Express CD into the CD-ROM drive. The CRE installer should automatically launch and bring you to the next step.

2. Click Finish to exit the wizard.

3. Select Next to begin the configuration process. You will be asked a series of questions that will determine how your system is installed.
### 10 Steps to Getting Started

#### Step 2 – Install and Start Cash Register Express

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.</td>
<td><strong>Cash Register Express</strong> will prompt you to select your industry type. Select <strong>Corporate Office for a Chain of Stores or Restaurants</strong> ONLY IF this computer is an office computer in your corporate office (not an office computer in a retail store). Otherwise, choose <strong>A Fine Dining Restaurant with Table Service</strong> or a <strong>Quick Service Restaurant with Counter Service</strong> depending on your type of restaurant.</td>
</tr>
</tbody>
</table>
| 5. | The next screen in the wizard will be the **Database Selection** tab.  
- Select **Configure This Computer** to start a NEW database or to connect to your server after you have already installed your server. For more information, see the **Configure Multiple Stations** section later in this manual. |
| 6. | You will need to answer a series of questions to help configure your system properly. |
| 7. | If you are connecting more than one computer in your store to a server you must select the right server that station will be connecting to. |

---

Cash Register Express
### 10 Steps to Getting Started

**Step 2 – Install and Start Cash Register Express**

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>8.</td>
<td>To setup a Store Server you will need to choose the appropriate Store ID by highlighting it. In addition, you need to select a Station. For connecting a Station to a Store Server just select the appropriate Station ID and click Done. <strong>Note</strong>: Every station must have a unique number.</td>
</tr>
<tr>
<td>9.</td>
<td>After you have configured your system select Exit and restart the program.</td>
</tr>
<tr>
<td>10.</td>
<td>In order to gain access to your new software you must now register it. Select the Register Now tab and scan or enter the registration number that came with your software. You must have an internet connection to register your software or call your sales representative to guide you through the manual registration process.</td>
</tr>
<tr>
<td>11.</td>
<td>If you are not connecting to a corporate office, Cash Register Express will proceed to the Login Screen after a brief loading process. If you are connecting to a corporate office, you will be prompted for the corporate office information before progressing to the Login Screen.</td>
</tr>
</tbody>
</table>
Employees are configured within the ‘Employee Maintenance’ screen of Cash Register Express. Cashiers and servers must be added into the system before they can log in and ring up sales. Other types of employees can be added and their hours tracked within CRE, even if their jobs don’t require them to use the POS. The steps below describe how to add your initial cashier into CRE; the ‘Employee Maintenance’ section later in this manual will describe additional employee options, job codes and how to record employee hours.

1. From the ‘Login Screen’, select ‘Employee Maintenance’ from the ‘File’ menu. Only the administrator can access this screen; enter the default administrator password ‘admin’ (without the apostrophes) to proceed.

2. Click the ‘Add Employee’ button to create a new employee record. Assign a unique Employee ID (which could be their initials or some other unique identifier), password and a ‘Display Name’ that prints on the receipt. If you would like to assign a secure login card to this employee, swipe the card in the ‘Card Swipe ID’ box.

3. Assign security permissions by touching the dropdown list and selecting Yes (the employee can do this), No (they can not), Prompt (they can with manager’s permission) or Override (they can and are a manager for this function.)

4. Touch the ‘Save’ button. Your employee has been added! Add any additional employees you wish to configure and then touch the ‘Exit’ button to go back to the Login Screen.
Cash Register Express has hundreds of built-in features that can be turned on or off. The ‘Setup Screen’ includes many of these options, organizing them into multiple tabs. You can access the ‘Setup Screen’ from the ‘Login Screen’ by clicking on the ‘File’ menu and ‘Setup Screen’ – you must use the administrator password to enter this screen (default: admin.) Global settings only need to be configured once for all stations while settings that are not global need to be configured once at each station. Below is a chart of recommended feature settings per vertical:

<table>
<thead>
<tr>
<th>Feature</th>
<th>Tab</th>
<th>Retail Clothing Store</th>
<th>Grocery Store</th>
<th>Global</th>
</tr>
</thead>
<tbody>
<tr>
<td>‘Prompt Cashier ID’, requires a cashier to login for every check</td>
<td>Invoice Settings</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Change the ‘Receipt Size’ to ‘Short Receipt’ to print only the most important information</td>
<td>Receipt</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Enter the company information that prints on the receipt</td>
<td>Company Info</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Enter necessary credit card information if you are processing credit cards through Cash Register Express</td>
<td>Credit &amp; Debit</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Select the ‘Rapid Entry’ displays quick tender keys</td>
<td>Station Specifics</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Create text that will print on the bottom of a receipt as a coupon</td>
<td>Couponing</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>‘Quick Tender’ will show the amount of change on the invoice screen, eliminating a touch from every transaction</td>
<td>Quick Invoicing &amp; Alerts</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>“Allow Food Stamp Change” select if you want to allow cash change when overpaying with food stamps</td>
<td>Invoice Settings</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>‘Reason Codes’ allow you to choose a reason why you are accepting a return</td>
<td>Invoice Settings</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>“Combine lines” items scanned multiple times will appear on the same line item</td>
<td>Invoice Settings</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
</tbody>
</table>

You can read about the other settings and options in the ‘Setup Screen’ in our ‘F1 Help Section’ built into Cash Register Express.
10 Steps to Getting Started

Step 5 - Create Your Inventory Items

Your goods are separated into separate groups called **Departments**. A few examples of departments are **Sweaters**, **Pants**, and **Fruits**. Departments are used to organize your inventory items on the screen and also to report on your items. After your departments are created, you create items inside of each of your departments.

To begin creating your inventory list, touch the **Manager** Button on the top right of the **Login Screen** and enter a username and password (default username: 01, password: admin.) Navigate to the **Inventory Maintenance** screen inside of the **Administrative** tab.

To add a new department, touch the blue **Department for this Item** link in the top left of the screen. This will bring you to the **Department Maintenance** screen. Touch the **Add Department** button, type in a department ID (ex: SW1001) and description (ex: short sleeve v-neck) and touch **Save**. After adding the department, touch **Exit** to return to the **Inventory Maintenance** screen.

### General Information for Short Sleeve V-neck

<table>
<thead>
<tr>
<th>Department for this Item</th>
<th>Item Type</th>
<th>Item Number</th>
<th>Description</th>
<th>Cost</th>
<th>Price you charge</th>
<th># In Stock</th>
</tr>
</thead>
<tbody>
<tr>
<td>SWEATERS</td>
<td>Standard</td>
<td>SW1001</td>
<td>Short Sleeve V-neck</td>
<td>$4.17</td>
<td>$18.99</td>
<td>26</td>
</tr>
</tbody>
</table>

**To add a new item,** touch the **Add Item** button on the bottom of the **Inventory Maintenance** screen. The required information is on the top one-third of the screen:

- The **Department** this item will be inside of (ex: Sweaters).
- A unique **Item Number** (ex: SW1001, or an abbreviated form of the item name.)
- A **Description**, which will print on the receipts.
- Your **Cost**, which is the price you pay.
- The **Price you charge** the customer.
- An optional **# In Stock** value if you track ingredients or portions.
- Various tax options if you charge tax for this item.

Touch the **Save** button and the item will now be added to your inventory list. See the next step to change the default format of your button and customize with your own colors.
10 Steps to Getting Started
Step 6 – Configure Your Inventory and Function Buttons

The invoice screen where you place your orders is a highly customizable screen. By default, inventory items are displayed in the order you add them. The button is a default color. This configuration can be changed easily.

To change the look of your invoice screen, and configure function buttons and best sellers, touch the Manager Button on the top right of the Login Screen and enter a username and password (default username: 01, password: admin.) Navigate to the Touch Screen Configuration screen inside of the Setup tab and go to the Items & Departments tab.

![Touch Screen Configuration](image)

The functions in the Items & Departments tab are used to change the order, color, caption and picture of your menu buttons. You can also choose to make certain items or departments invisible.

- To change the color of a department or menu item button, click on the department (in the left list) or menu item (in the right list) and touch the Select Color button.
- Change the order of your departments or menu items by selecting them from the list and using the Up or Down button.

When you are finished making changes, touch the Save & Exit button. Your changes will display the next time you log into the menu screen.

**TIP:** Changes made to the inventory screen on one terminal automatically update ALL terminals in real time. You do have the ability to design different screens for specific terminals in your store without affecting the other terminals. To do this, select the Configure This Station Individually menu option from the Options menu on the top of the screen. If this is checked, any layout changes made within Touch Screen Configuration will not affect other terminals.
Cashiers must login to Cash Register Express before they can ring up customers or enter orders. The ‘Login Screen’ prompts cashiers for a user name and password, or alternatively the cashier can swipe their card to gain access.

1. To log into CRE, simply enter your ID and password (default for the demo is ‘01’ and ‘admin’), enter the employees pin code or swipe the secure login card you configured in the ‘Employee Maintenance’ screen in Step 3 above.

2. Once you have logged in to CRE the invoice screen will appear. Once your system is setup, most of your pos experience will take place in the invoice screen. From this screen you can easily access many of the setup options and do all of your cashiering.

A secure login card helps prevent one cashier from logging in as a different cashier (which is a hole for theft.) Without a secure login card, cashiers must type in a user name and password, which is visible to others close by. The only way to log in with the card is to swipe the card, protecting the cashier’s cash bank from others trying to steal money. You can buy these cards from pcAmerica.
Ringing up an item is easy. Simply select the department the item is in (examples: sweaters, T-shirt, cigars, equipment, etc) and touch the items to add to the check. You can also scan the barcode with the barcode scanner and the item will be added to the invoice grid automatically.

TIP: If the item is not listed on the layouts and it does not have a barcode to scan, select the Search button. This option lets you search the entire inventory for the item and by selecting it, the item will be placed on the current invoice.
10 Steps to Getting Started

Step 9 – A Few Basic Every Day Functions

You can access additional functions by touching the tabs on the bottom of the invoice screen. Below is an explanation of each of these buttons.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>F1 - Help</td>
<td>A shortcut to the Help section</td>
</tr>
<tr>
<td>F2 - Inventory</td>
<td>A shortcut to the Inventory Maintenance screen.</td>
</tr>
<tr>
<td>F3 - Clock In/Out</td>
<td>A shortcut to the Time clock screen</td>
</tr>
<tr>
<td>F4 - Customers</td>
<td>A shortcut to the Customer Maintenance screen</td>
</tr>
<tr>
<td>F5 - Price Check</td>
<td>This is where you can check the price and stock level of an item</td>
</tr>
<tr>
<td>F6 - Cash Sale</td>
<td>This will ring up the current invoice as a cash sale</td>
</tr>
<tr>
<td>F7 - Check Sale</td>
<td>This will ring up the current invoice as a check sale</td>
</tr>
<tr>
<td>F8 - CC Sale</td>
<td>This will ring up the current invoice as a credit card sale</td>
</tr>
<tr>
<td>F9 - On Account</td>
<td>This will ring up the current invoice on account</td>
</tr>
<tr>
<td>F10 – Cashier Fxns</td>
<td>A shortcut that will take you to the Cashier Functions screen</td>
</tr>
<tr>
<td>F11 – Invoice Info</td>
<td>A shortcut that will take you to the Invoice Properties screen</td>
</tr>
<tr>
<td>F12 – Item Options</td>
<td>This button controls whether or not the item options are visible</td>
</tr>
</tbody>
</table>

Delete -- This will delete the currently highlighted item on the invoice grid.
Discount -- This will discount the highlighted item on the grid, not the entire invoice.
Down -- Will scroll down to the next item on the invoice grid
Up -- Will scroll up to the next item on the invoice grid
Quan Change -- Will allow you to change the quantity of an item on the invoice grid
Price Change -- Will allow you to change the price of an item on the invoice grid

Void Invoice – This will void the entire invoice.
Hold Invoice – This will allow you to pull up an invoice that has been placed on hold.
TS Lookup – This will bring up an on screen layout of your items and departments.
Options – This will bring you to the View Options screen.
Step 10 is the most important part of the transaction – taking the money. The three most common forms of payment in most retail stores are cash, credit/debit card and gift card.

To pay for a transaction, touch the appropriate button. This will bring up the amount-tendered screen.

Cash Register Express’s amount tendered screen is built for speed and flexibility. The default amount is always the exact amount remaining. To enter a payment, touch in the amount and touch the payment method. If paying by gift card, credit/debit card or check, CRE will ask you for more information. You can also enable one-touch quick payment buttons for the most common tender amounts. CRE supports split tendering, meaning you can pay with more than one tender.

**SPEED TIP** Pay by credit card without touching a button; our unique ‘swipe-and-go’ feature allows you to pay by credit card or gift card without touching a button. All you need to do is swipe the credit card on the invoice screen and it will process the card. This is the fastest way to pay.

CRE gives you the ability to quickly ring in items and put them on a customer’s account.

**Congratulations!** You’ve rung up your first sale inside of Cash Register Express. You’ve covered the basics and can now use your new point of sale system. The remainder of this manual includes some useful information for configuring and using your Cash Register Express point of sale system.
On the surface, Cash Register Express is a very simple to use point of sale system. Cashiers can ring up customers quickly and accurately. Behind the scenes, however, your Cash Register Express retail point of sale system consists of multiple components, functioning together, that run on the Microsoft Windows operating system. Likely your computers are connected to the Internet for e-mail, credit card processing and a variety of other uses. In today’s world of computers a variety of risks (both internal and external) exist that you should protect against.

Viruses and worms are malicious programs written by outsiders that can cause serious damage to your data or even your computer. Unknown to you, these can be downloaded and installed on your computer by visiting an infected web page, downloading and running malicious programs or by an outside intruder accessing your computer from a different continent via the Internet. To protect yourself you should do the following:

- Install a router, which is an Internet buffer between you and the outside world. Routers help control who can access your computer and will help keep unwanted intruders out. Popular brands of routers include LinkSys and DLink, however you should do your homework and choose the router you feel most comfortable with.
- Install and activate a firewall which is an additional layer of protection against outside intruders.
- Anti-virus and anti-worm software runs on your computers and, if configured properly, can actively watch each of your actions and put on the brakes if you are about to download or use an infected file. It’s important to scan your hard drive regularly for viruses and also keep current with the latest virus updates (which can change very frequently.) Popular brands of anti-virus software include Symantec (Norton Anti-Virus) and McAfee, however you should do your homework and choose the anti-virus software you feel most comfortable with.
- Spy ware is another malicious form of software that can sneak onto your computers. The effects of spy ware vary from slowing down your computer to revealing your personal information with a wide array in between. Many anti-virus packages also protect you against spy ware, however you can also download additional packages that can scan for spy ware, eliminate it and protect against future infections.
- Hardware and database failure, while extremely uncommon, is a reality of life that you should protect against. Lightning may strike – literally – and fry a hard drive or files on your computer. The two best ways to protect against this are fairly simple. The first is to have a surge protector unit with a battery backup; common brands are APC and SmartPower, however you should do your homework and pick the one you are most comfortable with. The second way to protect yourself is to perform daily backups of your data that you keep off-site.
Your inventory, customer records and entire sales history is stored inside of your database. It is highly recommended you backup your data on a daily basis in order to avoid loss of data due to unforeseen circumstances. It is very uncommon to lose data, however it can be catastrophic for a business to lose their entire database. It is YOUR RESPONSIBILITY to backup your database on a daily basis. In CRE, backing up your database can be done easily through the Database Maintenance section of the File Menu of the Log In Screen.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1. From the <strong>Login Screen</strong>, click on <strong>File</strong>, then <strong>Database Maintenance</strong>, and finally then <strong>Backup Database</strong>.</td>
<td></td>
</tr>
<tr>
<td>2. Enter your Administrator’s Password and click <strong>OK</strong>.</td>
<td></td>
</tr>
<tr>
<td>3. Choose a backup folder and type a filename for the data backup file. We recommend using today’s date and keeping a week’s worth of backups at a time.</td>
<td></td>
</tr>
</tbody>
</table>

You can never be too careful when it comes to backing up your system. The only way to recover from a catastrophic occurrence, such as a fire at your store, is to have an off-site backup copy of your database. We recommend using high capacity backup drives or any removable mass storage device as part of your backup system. A removable mass storage device usually plugs into your computer through a USB port and will be recognized by your computer as another hard drive. Your computer will assign a drive letter and will be available through the windows explorer (see picture above). You may remove this device from your business each and every day to ensure that you can be up and running quickly in case one of these catastrophic events actually takes place.
Hardware Setup
Installing Epson Receipt Printer

It is necessary to add and configure the receipt printers you are using inside of Cash Register Express. CRE created a shortcut for you to install and configure your printer.

1. Click on the Windows Start button in the bottom left hand corner of the screen.

2. Select All Programs and find pcAmerica. Scroll to the right.

Your receipt printer driver will be installed automatically.

Note: Installing your driver may reboot your computer.

Cash Register Express
Fundamentally, configuring most of your printers inside of Cash Register express is done in the same manner. Therefore, please follow these directions to configure and assign your receipt printers, barcode printers, back office printer and any additional printers.

1. You must first install the printer drivers for each printer and test them to make sure they are printing correctly for Windows at each station. If you are not able to print a test page at each station in Windows then you will not be able to print in CRE.

2. Select the Friendly Printer Setup in the View Options screen (4L).

3. Select the Friendly Printer on the left and match it to the corresponding printer driver in the right side window.

4. Select the appropriate Printer Type on the bottom of the screen.

5. Select Save & Exit to update your settings.

* In order for your station to know the location of a printer you must assign and configure your printer at each individual station.
It is necessary to add and configure the Bar Code Blaster printer you are using inside of Cash Register Express. It is extremely easy and all you have to do is install a generic text read only driver, which is a standard Windows driver.

1. To add and configure your Bar Code printer within Cash Register Express go to the **Control Panel** inside the **Start** menu. (Depending on the version you are using you may have to access the **Control Panel** from your **Settings**).

2. Select the Printers and Faxes icon

3. Select Add a Printer from the Printer Tasks and click Next when the first Window Wizard appears

4. Select the local printer attached to this computer option and **UNCHECK** the automatically detect and install my plug and play printer option. Click Next
5. Select the port that the printer is on. If it is Parallel it is an LPT port. If it is Serial it is a COM port. Click Next

6. Under the list of Manufacturers select Generic and under the list of Printers select Generic/ Text Only. Click Next

7. Select No when asked if you want to use this printer as the default printer (no screenshot)

8. A Bar Code Blaster is unable to print a Windows test page from the generic test driver so select “No” for this option (no screenshot).
9. Click Finish
Pole displays face the customer and display the items you are selling as you ring them up. Other information such as amount tendered, change, the current day and time and discounts will appear on the pole display at the proper time.

1. Plug your USB pole display into the USB port on the back of your computer. Windows will automatically detect that new hardware has been plugged into the computer. Choose to install from a list or specific location and then click Next. If you are using a serial pole display that plugs directly into a COM port (and not a USB port), skip to step three.

2. Insert the Cash Register Express CD in your CD/DVD-ROM drive, click on Search for the Best Driver and check off the Search Removable Media check box. Click Next to continue; the wizard will search for the driver. If it asks you to grant permission to install the driver, always choose Yes or Continue.

3. From the Login Screen, click on the File Menu, then Setup Screen and type in the Administrator password. Inside of the Hardware Tab, click on USB option under the Pole Display Port selection. Click the Update button at the bottom of the screen to save your changes.
Credit card readers and bar code readers differ greatly but have two things in common. The first is they are both used to read data (either a magnetic card such as a credit card, or a bar code.) The second is they enter the information into the computer like a really fast typist – meaning they are as easy to install as keyboards – just plug them in!

Hooking up both devices is fairly easy. Both the credit card reader and the bar code scanner are plug-and-play, meaning you simply plug them in and they work without installing any software or drivers.

Credit card readers (also referred to as MSRs or Magnetic Stripe Readers) are fairly simple devices that allow you to swipe a credit card into Cash Register Express. MSRs read the data on the magnetic stripe on the back of the card and automatically type it into Cash Register Express. In addition to credit cards, you can also swipe gift cards, loyalty cards and security cards through the same reader.

Your ELO touch screen may have a credit card reader bolted to the side. While this provides for a nicer looking presentation, the credit card reader still has its own cable and is the same as described above.

Bar code readers (or scanners) are used to scan bar codes on different products such as sodas, juice and milk containers, candy, t-shirts and other items. Loyalty cards can also use a bar code instead of a magnetic stripe reader. A simple scan of the item will read the bar code into the point of sale system and ring it up.
Hardware Setup
Cash Drawer

1. The majority of cash drawers plug into the bottom of the receipt printer. To install a Cash Drawer, first make sure the cable that comes with your cash drawer is securely plugged in to both the cash drawer and the receipt printer. A cash drawer cable looks similar to a phone cable. There is often writing on the cable that says ‘TO PRINTER’ and ‘TO CASH DRAWER’ to ensure it is connected correctly.

2. Inside of the Setup Screen, drop down the Default Cash Drawer Port inside of the Hardware tab and select Epson Receipt Printer Driven if your cash drawer is connected to an Epson receipt printer (the most common.) This will pop open the cash drawer attached to your receipt printer for all cash transactions.

If you are using more than one cash drawer at a register, please refer to additional documentation or contact technical support for assistance.
Hardware Setup

Installing the ELO Touch Screen

1. The ELO touch screen monitor has three plugs. The first is a standard power cable. The second cable is a USB cable which must be plugged into one of the USB ports on the back of your computer. The third cable will plug either into the VGA port or the DVI port depending on your computer. After connecting the touch screen, insert the CD that came with the ELO Touch Screen monitor which will start the ELO Setup Wizard.

2. The ELO driver welcome screen will ask you what type of drivers you would like to install. Select USB (unless you are using a serial touch screen) and click Next to continue. Follow the prompts (clicking Yes and Next when applicable) to install drivers for the ELO touch screen.

On the last page of the ELO Setup Wizard, click the **Calibrate ELO Touch Screen Monitor** button. A new window will appear instructing you on how to correctly calibrate and align your touch screen. Follow the on screen instructions. In the future, if you touch the screen and the mouse pointer is not directly beneath your finger, you will need to recalibrate the touch screen monitor.
In addition to many different scale types, Cash Register Express also supports Scanner Scales. Connect the port on the scale to an open COM port on your computer. You will also need to scan the program bar code. For instance, a Metrologic scanner scale will come with a Stratos bar code for you to scan.

Two options must be configured inside of the Setup Screen in order to use your scale.
- First select your scale model from the Primary Scale Type dropdown.
- The second step is to select the serial COM port it is connected to from the Weight Scale – Primary list.

CRE will ask you to enter an optional tare amount, which is the weight of the container a weighed item is sold in (ex: a plastic salad container.) The tare value can also be set by the item inside of Inventory Maintenance.

Verifone PinPads

Verifone PinPads must be connected to a COM port on your computer. Then configured inside of the Setup Screen in order to use your PinPad. First, select your model from the PinPad Type dropdown. Second, select the serial COM port it is connected to from the PinPad Port list.

Note: For Maximum security, pinpads are encrypted. It may be necessary for some models to be shipped to pcAmerica for encryption prior to installation. Please ask your pcAmerica sales representative for assistance.
Cash Register Express supports scales that are directly connected to the computer (where items are weighed at the register) as well as deli scales, where the items are weighed at the deli or other food preparation station, and a bar code label is printed and affixed to the item.

1. Cash Register Express supports two types of scales that directly connect to the PC. The CAS PD-1 and the Weighttronics NCI-6720 weight scales both connect to the serial port on the back of your computer.

2. Two options must be configured inside of the Setup Screen in order to use your scale. First select your scale model from the Primary Scale Type dropdown. The second step is to select the serial COM port it is connected to from the Weight Scale – Primary list. CRE will ask you to enter an optional tare amount which is the weight of the container a weighed item is sold in (ex: a plastic salad container.) The tare value can also be set by the item inside of Inventory Maintenance.

NOTE: Checking off the Auto-Weigh property of an item (found in Inventory Maintenance) will automatically query the scale for a weight whenever you sell it.

Cash Register Express can scan and properly interpret the standard UPC random weight bar codes printed by many deli scales such as the CAS LP-1000 or Hobart weight scales. This scale does not interface with the computer. For assistance in setting up your random weight bar code printing scale, consult the manual that comes with the scale or contact the manufacturer.
There are two types of passwords inside of Cash Register Express.

**Employee passwords** are passwords that are assigned to an individual employee. A description of the use and configuration of the employee password is discussed in the ‘Tracking your Employees’ section.

The **administrator password** is the “super password” of the system which can be used to access any function inside of the software. This password should only be known to the owner and the administrator of the system. Standard employees and managers should not receive this password.

By default, the password is ‘admin’ – you should change this Day 1 of using the system to enhance your security. To change your password, choose the ‘Change Password’ menu link under the ‘File’ menu in the ‘Login Screen.’

You can also create an administrator swipe card using the ‘Change Password’ screen. Swiping an administrator card takes the place of typing in the password, providing for faster and more secure overrides.
The ‘Set Tax Rate’ screen is accessed from the ‘Setup’ tab in the ‘Options Screen.’ Cash Register Express has three tax rates. Most stores use only the first tax rate, however some stores may charge different tax rates for different items. Change the percentage of the tax to match your local tax rate.

Some stores that deliver or ship items are required to charge the tax rate of the county or region where the goods are being sent. Cash Register Express allows you to configure different tax rates in different regions inside of the ‘Area Tax Rates’ tab. In order to apply an area tax rate to an order, the tax rate must be applied to the customer in customer maintenance and the customer selected for the invoice.
The receipt you give to your customers can be more than a simple listing of items; it can be an advertising piece that will encourage your customers to come back to your store. Receipts are configured in the ‘Receipt’ and ‘Company Info’ tabs of the Setup Screen.

Below are some of the most commonly used receipt options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Receipt Size</td>
<td>The ‘Short Receipt’ selection prints a more compact, nicer looking receipt and is recommended for stores.</td>
</tr>
<tr>
<td>Print Invoices</td>
<td>Set this to ‘Yes’ to print a receipt for every check, ‘No’ to never print receipts or ‘Prompt’ to ask you every sale if you’d like a receipt</td>
</tr>
<tr>
<td>Suppress Extra Signature Copy</td>
<td>If you do not desire a signed copy of the receipt. Turn on this option to suppress the signature copy.</td>
</tr>
<tr>
<td>Combine Lines on Receipt</td>
<td>If the same item is ordered more than once on the same check, this option will combine their quantities on one line on the receipt</td>
</tr>
<tr>
<td>Company Name</td>
<td>In the ‘Company Info’ tab, prints on the top of the receipt</td>
</tr>
</tbody>
</table>

**BONUS FEATURE:** It is also possible to print a logo on the top of the receipt using the Dell or Epson printers. The check box for printing the logo is located in the ‘Friendly Printers’ screen. Your logo must be uploaded to the receipt printer before it can be printed on your receipt. pcAmerica offers a logo upload service during which an engineer will format your logo artwork for the printer and walk you through uploading the logo to the printer. Please contact your pcAmerica sales representative to order this service.
Many retail locations have a color theme that is consistent throughout your stores. Cash Register Express can be configured to match. The colors of both the login screen and invoice screen are customizable. A picture of your choice can also be placed on the login screen.

The colors and pictures can be configured within the ‘Display Setup’ screen that can be accessed from the ‘Setup’ tab of the ‘Setup Screen’.

To change the background color of the ‘Invoice Screen’, click the ‘Set Form’s Background Color >>’ button and select the color from the color template that pops up on your screen. Similar buttons are used to select the colors and picture of the ‘Login Screen.’
Cash Register Express includes built-in credit card processing with the ability to process credit cards over the internet in as little as 2-3 seconds. Credit cards are sent securely to CoPay, CoCard’s internet gateway, for authorization. The use of integrated credit and debit card processing requires:

- A merchant account through CoCard Merchant Services. Application approval and fees apply. To apply for an account please contact CoCard at 1-800-317-1819 or by e-mailing info@cocard.info.

- A high speed internet connection (cable modem, DSL, T1 or other) with a speed of at least 128kbs. Please contact a pcAmerica Sales Representative for a recommendation of who to use for your local internet connection as well as a virtual private network.

- The use of an internet router with dialup backup is highly recommended. A router will help protect you from electronic intrusions from others on the internet and the dialup backup will ensure you can continue to process credit cards even if your high speed internet connection is down.

CoCard will provide you with a User Name and Password which must be inputted in the Credit and Debit tab of the Setup Screen of Cash Register Express.

Your CoCard User Name and Password merchant number and other credit card account information must be entered into the ‘Credit and Debit’ tab of the ‘Setup Screen’ inside of Cash Register Express.

For instructions on configuring an existing third party merchant account with Cash Register Express, please contact the PC Sales Department at 1-800-PC-AMERICA (1-800-722-6374) or sales@pcamerica.com. The use of a third party merchant account will require the purchase and configuration of an additional third party credit card module provided by pcAmerica.
It is fairly easy to configure multiple stations in Cash Register Express. Before configuring CRE, ensure your Windows computer network is properly installed. If you need over-the-phone help to assess and configure a computer network, please contact your sales representative. If your network is properly configured, please follow the steps below.

Cash Register Express is a redundant multi-user software package. A change made on one station will be shared amongst all stations in real time. In addition, the data is copied to each station – if the server goes down, the individual stations will continue to function independently.

It is very important to install your CRE Server first before installing additional workstations.

1. When installing CRE on your server, make sure the CRE Server application is installed first on your server computer. The installation of CRE Server is documented in Step 2 of the 10 Steps to Getting Started in the beginning of this manual.

2. Install Cash Register Express on the second station. When starting Cash Register Express, in the Database Selection in the startup wizard, select Connect to My Server. Cash Register Express will automatically detect your database over the network. If for some reason this automatic detection fails you will be prompted to manually select the database.

3. There will be a brief wait while Cash Register Express communicates with the server, downloads a copy of the data and starts for the first time on this station. This may take a number of minutes; however it is a fully automatic process.
Cash Register Express has the capabilities to print bar codes. You must have your inventory added and a Bar Code Blaster printer installed in order to print bar codes.

From the **Administrative** option select **Barcode Express**

**Note:** You can also access the Print Barcodes screen through the Inventory Maintenance screen.

The **Print Barcodes** screen should appear with a list of your inventory items. Select a **Type of Label** and choose which item you would like to print.

**Note:** You must add a number for the item you would like to print in the # Labels column. Anything with a zero will not print.

- Paper Adhesive Labels - 2.4” x 1” Paper sticker for general bar coding. Prints store name, price, bar code, item number and description

- Adhesive Butterfly Labels - 2.4” x .6” For use with jewelry or small objects where the label can wrap around it. Prints Description, bar code, item number and price.
Many retail locations now accept checks as a form of payment. Cash Register Express has a convenient feature that enables your store to process checks.

If a customer is paying with a check, select the check button from the invoice screen or the amount tendered screen.

The Process Check screen will appear and ask the cashier to enter the check number as it appears on the check. Select Enter.

**Note:** It is important to accurately record the check number for reporting purposes.

When using the **Check Processing** feature in Cash Register Express you will have to setup your system with the correct information. In the **Setup Screen** under the **Credit & Debit** tab, select the **Other** tab and enter the appropriate information in the **Check Processing** field.

**Tip:** A **Payment Type Breakdown** report can display all your check transactions between a specified date range.
Retail Stores increase throughput, customer satisfaction and overall profits by streamlining their operations to be as efficient as possible. Reducing transaction time by a few seconds can have substantial results. Cash Register Express is designed to provide the fastest checkout possible. Below are a few tips on how to speed up the check out and payment of every customer.

- **Swipe-and-go** credit card processing. In order to pay by credit card, most point of sale systems require touching a PAY or TENDER button and then the selection of the CREDIT CARD tender type. CRE is easier and fast; simply swipe the credit card on the menu screen. As soon as the card is swiped CRE will process the card. Eliminating these two button presses shaves a few valuable seconds off every credit card sale.

- **Gift card swipe-and-go** functionality provides the same speed savings if using Cash Register Express’s built-in gift card processing.

- **Quick Tender** button (configured in the Quick Invoicing and Alerts tab of the Setup Screen) turn on quick pay buttons for cash; this will turn on $5, $10, $20, $50 and $100 fast payment buttons for speedy cash payment.

- The **customizable buttons** on the invoice screen can be used to dramatically increase the speed of checking out a customer. The buttons should be color coded so your staff can associate a certain color with a certain product. Therefore, eliminating the need to search for an item every time. For example, in a grocery store you may want the color of your produce button to be green.

- **Secure Login Cards** are a fast and secure way to log servers into the system. Typing an ID and password (or a PIN code) takes a couple of seconds longer than swiping a card.
Selecting a Customer for the Invoice

Customer tracking is a very valuable function of Cash Register Express. The ‘Tracking Your Customers’ section of this manual (and the built-in F1 Help Section) describes how to add and modify customers and loyalty plans. To actually select the customer for the invoice, follow these steps.

1. Touch the ‘Find’ on the invoice screen to bring up the ‘Select Customer’ screen. The “Quick Search” button triggers a quick search by scanning, typing or a swipe of the customer card.

2. The “Select Customer” screen is an easy screen that allows you to search by first name, last name, customer number, phone number and company name. You don’t have to select which criteria you are searching on – you can simply type the information and it will search all fields.

3. After you find the customer, touch the line that has their record and touch the ‘Enter’ button to select them for the invoice. The selected customer’s name and bonus activity will appear under the Customer Info. Double click on Customer Info to see a Bill To, Ship To address and Picture. You can configure all customer information under the F4-Customers Tab at the bottom of the Invoice Screen.

4. The fastest way to select a customer is to swipe their loyalty card at any time in the invoice screen. In addition to fast customer selection, loyalty cards are a physical reminder of your business. Please contact the pcAmerica Sales Department to purchase customized loyalty cards with your logo.

All items sold to the selected customer will appear in that customer’s sales history in the reporting screen and the Customer Sales History report.
Retail stores often need to modify an order for a variety of different reasons. CRE provides delete, quantity changes, price changes and discount functions that are logged upon their use. In addition, the Up and Down arrow keys allow for easy access to any item on the invoice.

An item delete, price change, and discount are all permission based functions that can be set to be accessible for managers only. These permissions are configured in the Employee Maintenance screen (please see the Tracking Your Employees section for further details.)

A cashier can use the Quan Change button when there is more than 1 of the same item. They can scan or enter the item again or select the item on the invoice grid by scrolling to it with the Up and Down arrows and select the Quan Change button. CRE will then ask to enter the quantity. A cashier can also select the Quantity box at the top of the invoice screen and enter the correct amount.

Cashiers can delete items if they made a mistake ringing in the wrong item or if the customer does not want it anymore. Select the item on the invoice grid and touch the Delete button.

**Note: when you delete an item with quantity changes, all of the items will be deleted**

Touch the Discount button to discount individual line items on the invoice grid. Select the specific item on the invoice grid and choose the Discount button. Next the user will be prompted for a discount percentage. You can also discount the entire invoice by going to options>invoice properties.

Cashiers can also have the ability to change the price of an item. If a sale item was not discounted properly at the register a cashier can choose the item on the invoice grid, select the Price Change button and enter the correct price.

Discounts will show next to the item on the invoice grid. To remove a discount you must delete the item and ring the item in again.
The Purchase Order screen allows you to create and update purchase orders. To access this screen, select **Purchase Orders** from the **Administrative** menu in the **Options Screen**.

**Note:** When you login to the Purchase Order screen your open Purchase Orders will be displayed.

The main screen, displays all open purchase orders:

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PO #</td>
<td>This is the purchase order number. It is assigned by CRE and cannot be modified</td>
</tr>
<tr>
<td>Date</td>
<td>This is automatically set to the current date. It cannot be modified</td>
</tr>
<tr>
<td>Ref #</td>
<td>This is an optional field and is assigned by the user</td>
</tr>
<tr>
<td>Vendor #</td>
<td>After you have entered the vendor through the Vendor Maintenance screen select the vendor you are purchasing the order from.</td>
</tr>
<tr>
<td>Due Date</td>
<td>You must enter a due date for each purchase order. This is the date by which the order should get received</td>
</tr>
<tr>
<td>Status</td>
<td>This is the current status of the purchase order: O-open, C-closed, V-voided</td>
</tr>
<tr>
<td>Total Cost</td>
<td>This is the Total Cost of the order. It is automatically calculated by CRE and cannot be modified</td>
</tr>
<tr>
<td>Order by</td>
<td>Select <strong>Individual</strong> to order by individual item or select <strong>Case</strong> to order the item by the case</td>
</tr>
<tr>
<td>Destination Store ID</td>
<td>Select the store ID to which this order should be shipped from the pull down menu</td>
</tr>
</tbody>
</table>
To create a Purchase Order go to the Options Screen and select the Purchase Order tab in the Administrative menu. Select Add.

1. Select the type of request you wish to perform (Purchase Order or Transfer)
2. Select a vendor and a Due Date. All the other fields are optional
3. Pick a store destination and an order by selection.
4. Select the Add tab at the top of the page

5. Select the appropriate vendor. You will see all the items you order from that vendor in the Inventory Selection Grid
6. Select a destination Store ID
7. Choose an item by double clicking next to the Item Number. It will be added to the Added Inventory Grid
8. Select Save

**Note:** From the corporate office of Host Module location, you may create or edit purchase orders for each store. Simply select the store ID you wish to access purchase orders for and press the Purchase Order button. All additions or changes made will be transmitted to the selected stores.

**TIP:** In order to use the Reorder Low Stock Items feature, it must be set up in Inventory Maintenance (Ordering Info tab). When setup properly, once your stock level hits the reorder level you established, this feature will automatically (when you select it) reorder all the items to equal the Reorder Quantity + the Reorder Level. **Example:** you want 10 cases of bottled water on hand at all times and want to reorder when your stock level is at 2 cases. Set the Reorder Level to 2 and the Reorder Quantity to 8.
To receive a purchase order, enter the **Purchase Order** screen through the **Administrative** menu in the **Options Screen**.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select the Purchase Order you would like to receive by double clicking to the left of the PO #.</td>
<td>2. The General Info screen will appear, displaying the PO # in black bold letters.</td>
</tr>
<tr>
<td>3. On the bottom of the screen are some receiving options tabs, along with a Receiving Screen button on the right hand side.</td>
<td>4. Select Receive All to receive all the items on the Purchase order.</td>
</tr>
<tr>
<td>5. To receive one item on the PO, select Receive Item. You will be prompted to enter the Line number.</td>
<td><strong>Note:</strong> The Print tab will print the current PO and the Print History will print out a detailed record of all the items received against the current PO.</td>
</tr>
</tbody>
</table>
Common Retail Functions
Back Orders

This screen displays either the items that are currently on backorder for a selected customer or the customers for whom a particular item is on backorder. The grid will display the date the backorder was placed, customer number, item number, item name, the quantity placed on backorder by the customer, the current quantity in stock, amount paid, whether or not the backorder was prepaid, and the invoice number.

| To view items on back order for a customer | • Type the desired customer number in the For Customer # field.  
|                                           | • Only backorders for the entered customer will be displayed. |

| To view which customer has placed a certain item on back order | • Type the desired item number in the For Item # field.  
|                                                             | • Only backorders for the entered item will be displayed. |

There are three options for displaying backorders. Select All Open Backorders to display all backorders that have not yet been filled. Select Backorders Covered by Stock to only display backorders for items that are currently in stock. Select Backorders Not Covered by Stock to only display backorders for items that are not in stock.

To fill a backorder, double click on the desired backorder or highlight the desired backorder then click on Fill Backorder or press. The item will be added to the current invoice.
Checks can be voided before they are paid for and closed out. They can also be voided AFTER being paid for as long as it is within the same day by pulling back the check.

To void a check before it has been paid simply touch the Void Invoice selection in the Invoice Menu. This permission based function will save the invoice as a voided invoice with the next invoice number in sequence. The voided invoice totals will not be included in the sales totals.

You can also use the Void Invoice button on the Invoice Screen to perform the same function.

A check may be re-opened after it is closed out as long as the day hasn’t yet been closed out. After the check is re-opened you can either void the check (by using the Void Invoice selection as described above) or you may modify it and re-close it to another form of tender.

To re-open a check, use the Pullback Invoice button inside of the Options Screen. CRE will ask you which employee committed the invoice you would like to pullback followed by a listing of invoice numbers closed out by the selected employee. After the invoice is reopened it is as if it was never closed out.

TIP: A few of the reports inside of the Reporting Screen can be generated for voided invoices. It is good practice to run these reports on a regular basis as post voiding of checks opens up opportunity for theft. There are valid uses of the void function; an audit trail is kept to protect against theft in such a fashion.
Common Retail Functions
Sell and Redeem Gift Cards and Stored Value Cards

Gift cards and stored value cards are tracked inside of Cash Register Express with no transaction fees. They can be sold for any value. In order to sell a gift card select the **Sell Gift Card** feature in the Invoice menu. Swipe the new card and enter the dollar amount you wish to sell the gift card for. A gift card does not become active until the transaction is fully paid for and completed.

To pay by gift card, simply choose the **Gift Card** button from the **Payment Screen**. You do not need to enter the amount tendered, as Cash Register Express will automatically calculate the most desirable amount. A box will pop up asking you to swipe the gift card; swipe the card and CRE will deduct the proper amount from the gift card. If the gift card balance is more than the total amount due then CRE will deduct the amount from the gift card. If the balance is less, CRE will exhaust the balance on the gift card and display the new amount remaining to be paid by another form of tender.

**SPEED TIP:** If the gift card will be the only form of tender for the transaction, you can swipe the gift card at any time from the **Invoice Screen**. This will automatically deduct the amount from the gift card and end the transaction.

**NOTE TO FRANCHISEES:** The internal gift card system is ideal for single unit stores or for multi unit stores owned by the same owner. Many franchise stores have separate accounts and the money from gift cards will be automatically transferred from one account to another, which requires the use of a third party gift card processor. Depending on the third party gift card merchant provider, this may or may not be possible directly inside Cash Register Express. Please contact pcAmerica for further assistance.

Cash Register Express
Page 43
There are two steps to closing out a day in at a store. First, every employee should **Clock Out** of Cash Register Express. Employees can clock out by touching the clock out button on the **Login Screen**. A **Shift Report** will print out for the cashier providing it is setup in the Job Codes.

After each employee is clocked out, the manager of the store should run the **End of Day** function within Cash Register Express. The **End of Day** will scan all the checks for the day and ensure that they are all closed out, and that all of your employees are clocked out of the system.

Cash Register Express will prompt the manager for the amount of cash at the end of the day. This cash figure is a total for all cashiers for that shift. The store over/short amount will be printed in the **Daily Close** report as well as other vital information detailing the activities at the store for that day. This report can be re-printed in the future from within the **Reporting Screen**.

The **End of Day** function is subject to the **Perform End of Day** permission in the **Reporting** tab of the **Employee Maintenance** screen. Please see the **Tracking Your Employees** section for an explanation of how to configure permissions.
The ‘Customer Maintenance’ screen is used to add and update your customers. One customer is displayed at a time. Detailed information is stored in the tabs across the top of the screen. This screen is fully touch screen compatible, meaning you can double touch any field (or touch the field and then the keyboard button) to bring up an on screen keyboard.

Each customer within Cash Register Express must have a unique customer number. It is easy to use the phone number as the customer number, as this provides a fast and easy way to look up a customer if they forget their membership card.

Loyalty and membership cards are easy to assign to a customer. Below the ‘Card Swipe Ids’ label, touch the ‘Add’ button and swipe or scan the loyalty card.

The ‘General Info’ tab stores basic information such as name and address. ‘Extended Info’ has more, less commonly used information. Information regarding accounts receivable is stored in the ‘Account Info’ tab. Optional ‘Ship To’ and ‘Bill To’ addresses are stored in the ‘Shipping/Billing’ tab, followed by the ‘History’ tab which stores a detailed purchase history for the current customer. The ‘Notes’ tab has an open notes section. Custom configured ‘Properties’ can be established and populated to prevent certain customers from buying specific items (i.e. to avoid a customer buying food they are allergic to.)

Track Your Customers

Remember, your customers are a very important part of your business. You purchased a point of sale system that provides several great tools to track your customers and get them back into your store. You have the tools – now use them!

- Enter their name, address, phone number, e-mail address and other information.
- Run reports to see whom your best customers are; perhaps once a year you should have a special free product coupon for your best customers where you spoil them with something free and extra service.
- Configure customer loyalty plans to reward your loyal customers.
- Send mass e-mails with news and specials about your business.
- Remember your customers and they will remember you.
Adding customers in Cash Register Express is easy. Use the ‘Customer Maintenance’ screen to add your customers; this screen can be accessed in the ‘Administrative’ tab of the ‘Options Screen.’

1. Inside of the ‘Customer Maintenance’ screen, touch the ‘Add’ button on the bottom of the screen. This will set the screen to add mode, during which CRE is waiting for you to enter the information for the new customer.

2. Fill in the information on the top; a unique customer # as well as the customer’s first and last name is required. An e-mail address is highly recommended.

3. Optionally, fill in other pieces of information such as the phone number, name, company, etc.

4. Optionally, to assign a loyalty card to a customer, click or touch the ‘Add’ button and swipe the loyalty card through your magnetic stripe reader. Loyalty cards are a great way to increase repeat business. You can order customized loyalty cards with your logo from pcAmerica.

5. Click the ‘Save’ button to save the new customer in the database.

Modifying customers is just as easy. First search for the customer you want to modify (using the Look Up button on the bottom left corner of the screen.) Make your changes to the customer record and click or touch ‘Update’ at the bottom to save the updated information.
Accounts Receivable

Cash Register Express gives you the ability to open accounts for your customer, charge on account and send statements out at a later point in time. These features, as well as the ability to make payments and credit balance are part of the built-in Accounts Receivable system. To open an account for a customer, find the customer inside of ‘Customer Maintenance’ and touch the ‘O’ button in the ‘Account Info’ tab (and save the changes.) Touch the ‘Detailed Account Info’ button next to it to access the payment and credit screen, where you can apply payments to open balance and print customer statements.

Customer Loyalty

Offering incentives and bonuses to your customers is a great way to earn their loyalty and bring them back to your store many times in the future. Some great examples are a floral shop that offers a free bouquet on your birthday and also mails coupons with discounts based on how many times you visit – people continue to shop there to earn their points. The coffee shop downstairs from the pcAmerica office earns the majority of the coffee business in the building by offering a buy 9 get the 10th free coffee special. Many stores offer $2 off a purchase if you come back within a week of your last visit. These, and more, are part of the loyalty features built into Cash Register Express.

Most stores that offer loyalty plans will give out a loyalty card that the customer carries as a physical reminder of the store. They swipe their card at the time of sale in order to earn their loyalty points for the order. Customized loyalty cards are available from pcAmerica and may be assigned to customers inside of Cash Register Express.

It’s easy to set up customer loyalty inside of Cash Register Express. In the ‘Options Screen’, select the ‘Customer Loyalty’ function. You must create both ‘Loyalty Incentives’ and ‘Loyalty Plans.’ Incentives are the actual rewards you give to your customers, such as a free meal or $2 off the next purchase. Plans consist of one or more incentives. After you have created a loyalty plan, you can assign it to a customer by touching the ‘Loyalty Plan’ button in the customer’s record in ‘Customer Maintenance.’

The F1 Help Section includes a full description and tutorial for configuring loyalty incentives, plans and assigning them to customers.
Cash Register Express allows you to create inventory items, create recipes, create sale pricing, track inventory and configure retail and other inventory items. Creation and modification of these inventory items, as well as coupons, is done through the ‘Inventory Maintenance’ screen which can be accessed from the ‘Administrative’ section of the ‘Options Screen.’ A full tutorial of this screen is in the built-in F1 help section; below are some basic pointers to get you started.

You can add standard items from the Inventory Maintenance screen. Adding them through the Inventory Maintenance screen gives you more options and flexibility. Click on the ‘Add’ button to add a new item. You’ll have a choice of four different types of items:

- ‘Standard Item’ encompasses all inventory and SKU based retail items.
- A ‘Choice Item’ is not a real item, but rather it is a fake item that when ‘sold,’ gives you a choice of which item to sell. For example, you can create a Latte choice item whose choices would be Small Latte, Medium Latte and Large Latte. The advantage is one inventory button that drills down into choices, as opposed to an overwhelming number of menu buttons.
- The “Modifier” is used to group modifiers together. For example, if you have modifier items ‘Rare’, ‘Medium Rare’, ‘Medium’ and ‘Well Done’, you can group them into one modifier group called ‘Meat Temperatures.’ Using modifier groups simplifies creation of menu items; instead of adding four modifiers to many meat entrees, you can add the group once to each item. Note: This feature is mostly used for restaurants
- ‘Coupon’ items are created to give the customer a discount. They can be configured to give a flat amount or percentage off an entire check or only specific items. Coupons automatically calculate the discount amount based on price paid, date and time and other options.

Fill in the data for the item and click ‘Save.’ The most important fields for a standard item are the item number (must be unique), description, cost, price and tax rates. Modifying an item is just as easy. Find the item in our list by using the ‘Lookup’ button on the bottom left; modify the item and touch ‘Save Changes’ to update the item.
Special pricing is an extremely powerful feature of Cash Register Express. A variety of sale and promotional pricing can be configured at any time; these prices will automatically be used when the cashier rings in the items. For example, sale pricing on specific items can be pre-configured; during the allotted times the special/sale price will automatically be used without the cashiers having to apply a discount.

There are three main types of special pricing:

**Sale Pricing**: This function allows you to place an item on sale between certain dates. To create sale pricing for an item, click on the **Add** button in the **Special Pricing** tab under the Inventory Maintenance screen. Enter the percent of the sale mark down and select the start and end dates for the promotion. To remove a sale price for an item, select the desired sale price then click on **Remove**. To place an item on sale for only one day, select the same day for both starting and ending date.

Example: All Juicy Couture Sweatpants 10% off next week

**Bulk Pricing** is used to sell items at a reduced price when your customers buy more than one of an item. To set up a bulk price for an item, click on **Add**, enter the quantity needed to be purchased for bulk pricing, and then enter the new price. To remove a bulk price for an item, select the desired bulk price then click on **Remove**.

Example: Two apple pies for the price of one

**Time-Based Pricing** allows you to offer alternate prices on certain days within certain time ranges and is most commonly used for Black Friday (the day after Thanksgiving) or certain days that have designated sales. Retail stores often use time based pricing to attract customers during their non-busy hours. To enter time-based price for an item, click on **Add**, select the day on which you want to offer the sale price, and then enter the start and end times. To remove a time-based price for an item, select the desired price then click on **Remove**.

Example: A store may offer a sale on shirts during Fridays from 2PM to 5PM for a sale price of $8.00 while the normal price is $12.00.

**TIP**: If Black Friday is 7 AM to 4 PM, start your time-based price at 6:50 AM and end it at 4:10 PM. You may sell a few extra discounted items, but you will also avoid annoying a customer who is on line at 4:02 PM and wants the discount.

**Note**: The special pricing can only be used for a sale price or discounted price. You cannot increase the cost of an item in special or sale pricing.
Retail stores can carry anywhere from a few dozen items to hundreds of items and more. Regardless of how many inventory items your business sells, it is useful to break your items down into smaller groups of items to perform a certain task or search. In Cash Register Express, items can be grouped into Departments. Departments can be further grouped into Categories.

A few examples of departments are Jeans, Fruits and Wines. Common choices for categories are Produce and Clothes. The category breakdowns are easy to see which area of store is bringing in the most profit.

Please note that Cash Register Express comes with a default department of NONE. This department cannot be deleted.

The Department Maintenance screen can also be used to set up employee departments, which allows you to group your employees in different ways for functions such as labor scheduling. See the 'Department Type' description below for more details.

You can access the Department Maintenance from the Administrative tab of the Options Screen.

To add a department:

1. Enter the 'Department Maintenance' screen.
2. Click or touch the 'Add' button.
3. Type in a Department in the corresponding box (ex: Magazines)
4. Click or touch the 'Department Description' box (ex: US Weekly)
5. Type in a description for your new department.
6. Select a category and department type (or leave these as is)
7. Click the 'Save' button.

Optionally, you can check the Bar Tax Inclusive check box which includes tax built into certain items if they are ordered and immediately paid for at a bar station or any station. This provides for a fast cash transaction where the tax is built into the price for an even round number.

Categories are configured in the Category Maintenance screen, which is accessible in the button below the Department Maintenance screen. Adding a category is nearly identical to adding a department.
Every store must take physical inventory periodically, even when using a point of sale system. It is important to compare how much of each item you really have as opposed to what the computer tells you. By doing physical inventory, you will find where inventory shrinkage occurs. You may also find areas of your store that are more prone to theft. Tracking your inventory closely will actually save lots of money as a result.

Inventory Track Express is a tool that has been incorporated into Cash Register Express that acts like a physical inventory control panel. You may use portable data terminals, like Symbol's Palm Pilot based SPT series handheld units with built-in bar code readers, for fast and easy inventory counting. pc America has created a palm-based program called Pocket Inventory for these handheld units. Pocket Inventory has 3 functions:

<table>
<thead>
<tr>
<th>Count Inventory</th>
<th>A quick, point and scan, inventory counter. Just point the Symbol Palm Unit's bar code scanner to the bar code and scan it. Pocket Inventory will generate a list of bar codes and their corresponding quantities.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit Inventory</td>
<td>You may upload your inventory from CRE to Pocket Inventory. This feature will allow you to be out in your store, bring an item onto the portable Palm unit's screen and edit the description, cost, price, tax status, quantity and even print a bar code on the fly with the optional Code Ranger Plus portable bar code printer from Cognitive Solutions. Contact your pcAmerica sales representative for pricing on the Code Ranger Plus.</td>
</tr>
<tr>
<td>Purchase Orders</td>
<td>You may upload the open Purchase Orders from CRE to Pocket Inventory. Once the PO shipment arrives, you may use Pocket Inventory to bring up the purchase order information, scan the items on the shipment to mark down what was received</td>
</tr>
</tbody>
</table>
If you are a retailer that has multiple stores, CRE has the capabilities to transfer inventory from one store to another. The Inventory that is depleted or added will automatically be reduced or added to that store’s inventory.

To access the Transfer inventory feature select the **Transfer** tab inside the **Inventory Maintenance** screen.

The Mass Transfer screen will allow you to scan or manually enter the item(s) you wish to transfer:
- Select a Quantity
- Select a Source Store ID and Destination Store ID
- Select Transfer

**Note:** You can either transfer out from the host store or accept a transfer into the host store from a different location.

**Returned Items**

Cash Register Express has a simple solution for returns. When an item comes back, enter a negative number in the Quantity field and scan or enter the item. Close out the transaction like a normal sale (cash/credit/debit etc.) You’ll see the price in parentheses ( ) indicating a negative sale and a red bar in the invoice grid.
Choice Items

A Choice Item is a not a real item, but rather provides a way to have the user choose from a list of actual menu items. For example, if I have a coffee shop that sells a small Cappuccino 12 oz., medium Cappuccino 16 oz. and large Cappuccino 20 oz., you can create a choice item called cappuccino. When you sell this choice item, you will be prompted to choose which of the three sizes of cappuccino is being sold. This simplifies your menu – you can replace three buttons for Cappuccino on the screen with one button that drills down into a choice of sizes.

Choice items are primarily used to limit the number of items on the main invoice screen and provide drill downs for quicker, easier selection.

In the example above, the choice item is the 'fake' item called 'Cappuccino’. The items included inside of the pass-along are the 'real' items, the choices that are displayed when you 'sell' the pass-along. In this example, the items would be Cappuccino 12 oz, Cappuccino 16 oz, and Cappuccino 20 oz.

Some retail stores may use this for a clothing menu. The person configuring the inventory would create all their clothes as standard inventory items, and create an 'H Clothes' Choice, with all clothes that start with the letter H inside of it. Instead of scrolling through searching for Hanes, the cashier can touch H and see a drill-down with Hanes amongst a few other H clothes.

When setting up a Choice Item you can include a Prompt which is the question that is asked to the server when provided with the individual choices. For the above example, a suitable question would be “What Size Cappuccino?”
Coupons are commonly used in grocery stores. A couple of examples are buy one get one free on Thursday and 10% off all men’s clothing 3 – 5 PM daily. In order to account for the wide variety of types and restrictions of coupons in a store, the Cash Register Express inventory screen includes an item type just for coupons.

Coupons may be configured to give either a percent or a flat dollar amount off the Grand Total. Redemptions of a coupon appear as a sale of an item for a negative dollar amount. It is a good idea to put all of your coupons in one department for easier reporting.

The discount for coupons are triggered either by adding the coupon to a check, or tying it to a loyalty plan where the customer will get the discount either at award time or every time they are selected as the customer for a check.

The **Days Valid** tab is used to set what days and time the coupon is valid. Use the **Add Time** and **Delete Time** buttons to configure the times. You may also set the expiration date for a coupon date by checking the **Does this coupon expire?** check box and filling in the expiration date.

The **Restrictions** tab allows you to specify which items, departments or categories are included or excluded in the coupon discount. Coupons can also be made exclusive of specific items; this feature is often used to restrict a check to include only one coupon.

There are a number of other restrictions below the grid including a minimum dollar amount, number of days between use and other restrictions to make your coupons more customizable.
Cash Register Express allows you to configure, ring up and track the sales of SKU based items with bar codes. You can also track retail items that do not have bar codes. To do this, add a standard item to inventory. Scan (or type) the bar code into the Item Number field. The main fields on the top third of the screen should be filled in for every retail item you carry in your store.

<table>
<thead>
<tr>
<th>Item Number</th>
<th>Description</th>
<th>Cost</th>
<th>Price you change</th>
<th># In Stock</th>
</tr>
</thead>
<tbody>
<tr>
<td>762111206039</td>
<td>Espresso Roast 1 lb</td>
<td>$4.00</td>
<td>$8.95</td>
<td>12</td>
</tr>
</tbody>
</table>

It is easy to ring up a SKU based item inside of Cash Register Express – simply scan the item at any time during the transaction using a bar code scanner. The quantity sold will deduct from the in stock value in the Inventory Maintenance screen.

There are a variety of useful inventory reports in the Reporting Screen to help you track your retail items. The simple numerical and alphabetical listings will show you what is currently in stock. More advanced reports, such as the Item Activity Report will show you what was sold and received of each item between a date range.

Cash Register Express also has a built in Purchase Orders screen (accessible from the Administrative tab of the Setup Screen.) This screen can be used to place orders for items, print purchase orders and at a later time receive the items when they arrive at your store. You can learn how to use the Purchase Orders feature by reading the F1 Help Section.
It’s important to track your employees and configure functions they have access to within your point of sale system. Employees and security, as well as job codes and other employee settings, are configured in the ‘Employee Maintenance’ screen, which can be accessed from the ‘File’ menu of the ‘Login Screen.’

A full tutorial of this screen is in the built-in F1 help section; below are some basic pointers to get you started.

The basic steps of how to add an employee are included in step three in the ‘10 Steps to Getting Started’. Modifying an employee is just as simple; navigate to the employee using the buttons in the bottom left corner of the screen, modify the employee and click or touch the ‘Save Changes’ button to update the employee.

### Swipe Cards and Security

To assign a card, swipe the card into the ‘Card Swipe ID’ field using the MSR.

**NOTE:** The **Display Name** for an employee will print on an invoice when they are the cashiers. If you desire, fill this field in for the results of a friendlier receipt.
Cash Register Express can be configured in a flexible fashion, allowing you to define which employees can access which functions inside of the system. It is important to understand and properly configure the permissions to ensure employees can only access the functionality you want them to access.

Security is a priority within Cash Register Express. The ‘Employee Maintenance’ screen has dozens of permissions which can be set individually for each employee and determine what that employee is allowed to or restricted from doing. Most of the permissions have four settings:

- **Yes** allows the use of a function.
- **No** restricts the selected function.
- **Prompt** asks for manager’s permission to use the selected function.
- **Override** makes the selected employee a manager for the selected function, meaning they can access the function and also give an employee with the ‘Prompt’ setting permission to use this function.

The **Exceptions Tracking** features of CRE provide a great way to identify and track suspect activity. If you log a certain activity as an exception (ex: Cashier 01 ringing in a discount or Cashier 03 opening the cash drawer for change), CRE will record this instance in an Exceptions Log for later viewing. Even though many of these functions are already recorded for all employees, this will provide you with a list of functions and employees you would like to specifically watch.

**Exceptions Tracking** is a great analytical tool that will provide you with specific lists of activity you define as suspect without having to wade through pages of information. You can view the results in the **Operational Exceptions** report, viewable in the Sales tab of the Reporting Screen.

Configuring **Exceptions Tracking** is easy; simply check the Log as Exception check box for each permission and employee combination that you wish to watch. This setting is configured individually for each employee and permission to provide maximum flexibility.
If you are just using the basics then you don’t need to worry about job codes and the employee time clock. However these are valuable features that are easy to configure and will help you control your business.

Simply put, Job Codes are the different jobs that your employees work inside of your business. A few examples are cashier, janitor, manager and crew member. Job codes can be configured inside of the Employee Maintenance screen (by clicking the ‘Job Code Setup’ button.) You can configure if an employee working a certain job code may access the POS, if they handle cash and how many shift reports to print at the end of their shift. You can read more about these options in the built-in F1 Help Section.

After creating job codes, they can be assigned to an employee using the ‘Add’ button in the ‘Job Codes & Wages’ tab in ‘Employee Maintenance.’ Hourly wages and overtime wages are configured in the same tab. An employee can have more than one job code each with a different wage; when they clock in, they will be asked which job code they are working this shift.

To track the hours worked by your employees, have them clock in by touching the clock icon on the Login Screen. Staff members use the same icon to end their shift and clock out. In the occasional situation an employee forgets to clock in or clock out, the ‘Time Clock Management’ screen can be used to modify times. If you want to enforce that your employees clock-in before starting their shift, select the ‘Require Clock-In Before Login.’

Typical steps for an employee:
1. Employees and cashiers clock in when they come in for the day.
2. They take orders and close out checks throughout the day.
3. At the end of the shift, the employee clocks out.
4. A shift report print is printed upon clock-out which includes a cash count that shows how much money was taken in and removed. At the bottom is an over/short amount that helps ensure that your cashiers are properly reporting and turning in the money they collected throughout the day.
Cash Register Express has dozens of built-in reports that help you view and analyze sales figures, inventory and ingredients, efficiency, employee activity, customer history and a substantial amount of additional statistics and data regarding your store operations. These reports are generated from the reporting screen, which can be accessed from the ‘Administrative’ tab of the ‘Options Screen’. There are six categories of reports you can choose from, listed down the left side.

To run a report, first select the report you’d like to run by clicking on its name in the ‘Report’ list box. Each report can be customized on the fly by selecting one or more pieces of criteria such as a date range, one or more cashier IDs, one or more registers, etc. For example you can run the ‘Receipt Listing’ report to see a detailed sales transaction listing for cashier 01 from April 1st, 2006 through April 5th, 2006.

The built-in reports will satisfy all or most of your reporting needs. Cash Register Express includes a built-in report writer which can be accessed by clicking on the ‘Advanced Reporting’ button. The report writer is for more computer savvy users that are familiar with report builders. Training Sessions on how to use the ‘Advanced Reporting’ section can be purchased from pcAmerica.
Most store operators use less than ten of the built-in reports. It is a good idea to click on each report and read the description of what information the report includes. Many users miss out on valuable information simply because they haven’t taken the time to learn the figures that each report generates and how it will benefit their business. Listed below are a few of the most useful reports.

<table>
<thead>
<tr>
<th>Report Name</th>
<th>Category</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Invoice Totals Report</td>
<td>Sales</td>
<td>Summary of each invoice processed within a date range</td>
</tr>
<tr>
<td>Invoice Totals - Daily</td>
<td>Sales</td>
<td>Summary by day with totals, # of tickets and average dollar amount per ticket</td>
</tr>
<tr>
<td>Grand Totals by Payment</td>
<td>Sales</td>
<td>Total dollar amount collected by each payment method with the option to</td>
</tr>
<tr>
<td>Method</td>
<td></td>
<td>break down by cashier</td>
</tr>
<tr>
<td>Detailed Daily Report</td>
<td>Sales</td>
<td>Detailed report with payment breakdowns (receipt printer)</td>
</tr>
<tr>
<td>Detailed Department Sales</td>
<td>Sales</td>
<td>Detailed report with payment breakdowns (receipt printer)</td>
</tr>
<tr>
<td>General Hourly Report</td>
<td>Sales</td>
<td>Breakdown of income by hour within a day</td>
</tr>
<tr>
<td>Grand Totals by Date</td>
<td>Sales</td>
<td>Quick figure of how much was sold in a date range</td>
</tr>
<tr>
<td>Receipt Listing</td>
<td>Sales</td>
<td>Detailed summary of each check within a date range</td>
</tr>
<tr>
<td>Shift Summary</td>
<td>Sales</td>
<td>Summary of each employee’s shift</td>
</tr>
<tr>
<td>Financial Summary</td>
<td>Sales</td>
<td>Detailed ‘picture’ of your business within a date range, gathering all of your</td>
</tr>
<tr>
<td></td>
<td></td>
<td>key figures in one compact report</td>
</tr>
<tr>
<td>Invoice and Operational</td>
<td>Sales</td>
<td>List of functions that you have identified as suspicious with employee ID</td>
</tr>
<tr>
<td>Exceptions</td>
<td></td>
<td>and manager ID. Useful to prevent theft.</td>
</tr>
<tr>
<td>List Alphabetical Inventory</td>
<td>Inventory</td>
<td>Summary of your in stock inventory and value</td>
</tr>
<tr>
<td>Reorder Report</td>
<td>Inventory</td>
<td>Detailed summary of each check within a date range</td>
</tr>
<tr>
<td>Top Sellers</td>
<td>Inventory</td>
<td>Summary of your in stock inventory and value</td>
</tr>
<tr>
<td>Discrepancy Report</td>
<td>Inventory</td>
<td>Identify what is in stock versus what should be in stock, use this to identify</td>
</tr>
<tr>
<td></td>
<td></td>
<td>theft, waste and other loss factors</td>
</tr>
<tr>
<td>Top 10 Sellers</td>
<td>Inventory</td>
<td>Another report to identify the best sellers in your inventory</td>
</tr>
<tr>
<td>Pending Orders \ Details</td>
<td>Inventory</td>
<td>View the commissions you rewarded to your employees for recommending and</td>
</tr>
<tr>
<td></td>
<td></td>
<td>selling certain items</td>
</tr>
<tr>
<td>A/R Summary</td>
<td>Customer</td>
<td>View a list of all outstanding accounts</td>
</tr>
<tr>
<td>Purchasers of Item</td>
<td>Customer</td>
<td>View all customers who purchased a specific inventory items so you may</td>
</tr>
<tr>
<td></td>
<td></td>
<td>market to them for similar new items</td>
</tr>
<tr>
<td>Sales History</td>
<td>Customer</td>
<td>Detailed list of which customers ordered which inventory items</td>
</tr>
<tr>
<td>Hours and Wages</td>
<td>Employee</td>
<td>List the hours and wages of your employees</td>
</tr>
<tr>
<td>Employee Listing</td>
<td>Employee</td>
<td>Generate a report listing the ID and personal info of each employee</td>
</tr>
<tr>
<td>Commissions</td>
<td>Employee</td>
<td>View the commissions you rewarded to your employees for recommending and</td>
</tr>
<tr>
<td></td>
<td></td>
<td>selling certain items</td>
</tr>
<tr>
<td>Late Rentals</td>
<td>Rentals</td>
<td>A list of all rentals that are currently out of the store and beyond the due</td>
</tr>
<tr>
<td></td>
<td></td>
<td>date</td>
</tr>
</tbody>
</table>
Before You Begin

In order to communicate between stores, they must have a way of connecting to a main location where the corporate database will be stored. Normally, the corporate database is located in the main office of the entire storewide operation. This is where the Host Module will be loaded onto an office computer.

About Virtual Private Networks

In recent years, the most popular and cost effective way to connect one location of a business to another is by a Virtual Private Network (VPN). A VPN uses the Internet to communicate from one location to another. Using a DSL, Cable, T1/T3, ISDN, or even modem, you can connect one location to another via a VPN, where your data will be encrypted to protect your business from unwanted intrusion. A VPN, in effect, puts one location on the same network as another with security.

It is our recommendation to use a dedicated Internet connection, such as DSL, T1/T3, or Cable Modem so as to prevent drops in your Internet service. We DO NOT recommend connecting through a modem using a regular telephone line.

You must have a VPN, or equivalent form of communication, between your business locations prior to setting up your CRE multi-site point-of-sale system. You may contact pcAmerica for recommendations on companies who will help you set up a VPN for your business.
On a multi-user environment, it may be necessary to adjust firewall or anti-virus worm protection settings to allow communication between computers. Picture your network as a road map where each computer is like a house in a neighborhood. Each house has an address and you must travel by a road or route to get to another house. Much like this roadmap, each computer has an address and data must travel from computer to computer through a route, called a port. In order to block unwanted visitors to your computer, it is necessary to use a firewall or some form of worm protection. Sometimes firewalls and worm protection software may block data that you need. Therefore it is necessary to make sure the port that CRE uses is unblocked. You may put certain restrictions where only certain computers can have access to this port.

By default, CRE communicates through Port 50,000. When creating an exception to the firewall, open the port you specify as TCP.
To configure the Microsoft Windows XP (Service Pack 2) Firewall:

1. Go to Control Panel

2. Double click on the Windows Firewall icon

3. Click the Exceptions tab
4. Click Add Port
5. In the Name field, you may specify a name to identify the program (CRE).

6. In the Port Number Field, type the port that you choose to have CRE listening on. In our example above, you would choose 50,000.

7. Choose TCP under the Port number field.

8. Click Change Scope.

9. Choose My network (subnet) only. This will only allow computers within your local network to have access to this computer through the port specified above.

10. Click Ok twice to save the changes and exit the Windows Firewall Settings.
The Corporate Host Module must be installed at the same location as the corporate database. You may purchase licenses of the Host Module on as many computers as you need, as long as they have a direct connection to the main corporate database.

**Step 1: Configure your station to be a Corporate Host Module**

Once you have installed CRE from the CD, you will be taken to a welcome screen where you will need to select the Industry Type. If you have already installed CRE on this station, then you can reach the Industry Selection Screen from the File Menu of the Log In Screen, under Select Industry. You will be prompted for the Administrator’s password to access the Industry Selection Screen. To set this station to be the Host Module, select A Corporate Office for a Chain of Stores or Restaurants, then click Next to continue.

**Step 2: Create a New Database**

1. Insert the Cash Register Express CD to install the program. The program will begin automatically.
2. Click OK to start the wizard.
3. Click Next to install CRE.
4. Agree to the licensing agreement by checking the appropriate box and click Next.
5. To create a **Corporate Server** you must select **Standalone** and click Next.

6. Click Install. The program will start to install automatically.
7. Click Finish.
8. Once you have installed the program, you must Browse the CD for the `enterprisecorpserverinstall.exe` file and double click on it to install.
9. Agree to the licensing agreement by checking the appropriate box and click Next.
10. CRE will place a shortcut to the program on the desktop of your computer. From the desktop double click on the CRE icon and click Next.
11. Click Next when prompted.

When installing for the first time, you will be prompted to select one of three options related to connecting to a database. To begin a new corporate database, select **Start a New Store or Restaurant**. Once you have selected this option, your database will automatically be created and activated on this computer.

Now that the Corporate Database has been created you may now setup and configure your stores. Once you have configured your stores, each store’s server can connect to the corporate database under their store id. The next section explains how to navigate the Host Module and set up your stores.
The common areas of the host module are the File Menu, Store Selection section, and the Host Functions buttons. These sections are apparent throughout the entire program, and are accessible at all times.
The File Menu

- **Select Industry** - You may specify the interface you wish to run this station as. You may configure it to be a retail station, restaurant station or a host module station.
- **Select DB Location** - You may choose the location of the SQL database. You may also choose to use your own database, a new blank database, or a sample database.
- **Set Store ID** - You may set the store ID of this register. When setting the store ID of this station, these settings will remain until you change it.
- **Set Station ID** - This sets the default station ID of this register. Once you change the station ID, the setting will remain until you change it.
- **Compact and Repair Database** - This is a utility that compacts and re-indexes an Access database. It is not necessary to use this feature if you are using a SQL database.
- **Configure Enterprise** - You may set up and configure your station to synchronize data with a main or corporate database within your operation. When the Enterprise feature is activated, you will achieve a level of redundancy so as not to lose your ability to operate your station should the network fail.
- **Register** - This is where you register and activate your station. Once you register the station, it will be unlocked for unlimited use.
- **Exit** - You may exit to the log in screen from this selection.
The Store Selection section is where you may choose which stores to modify or configure data. If you would like to view and edit inventory for store 1002, simply select and highlight 1002 and enter the Inventory Maintenance. All the data that you edit or add will be sent to that store. You may select multiple stores by clicking on each one. When multiple stores are selected, all the data for the selected stores will be sent to those stores.

**NOTE: IF NO STORES ARE SELECTED, THE HOST MODULE WILL BE SET TO MODIFY DATA FOR ALL STORES**

To clear the selections you have made, you may either click on the highlighted store to unselect it or Clear Selection to clear all selections at once.

The side bar of the Host Module is made up of buttons that take you to the functions that you may perform. You may view reports, edit inventory, vendors, departments, categories, purchase orders, customers and loyalty plans as well as configure your stores. In the next section, we will describe each function in more detail.
Setup

The Setup Screen is where you set up your stores, configure your employees, set corporate wide tax rates, change administrator passwords and manage employee time-clocks.
To add a store, simply press the add button and type the store ID you wish to use for the new store. You may choose to duplicate inventory to the new store by highlighting the store ID you wish to duplicate inventory from and pressing the Duplicate Inventory button. You will be prompted to type which store you would like to duplicate the inventory to. If you have multiple stores that you wish to copy from an original store, you may type them all in separated by a comma. See the picture below.

This will copy the inventory from the highlighted store to the store(s) you specified.

You may delete a store by pressing the Delete button.

Finally, you may use the Zero Inventory button to set all in stock levels to 0 for the stores that you select. You may wish to do this when you start a brand new store where you are unaware of the stock levels. We recommend doing a physical inventory and adjusting the levels from the store. The in stock levels will then transmit to the host.
The **Setup Tax Rates** section allows you to enter the tax rates for each store. Each store can have up to 3 tax rates. You may choose the tax rate in the grid and simply make the change right on screen.

Alternatively, you may select the **Area Tax Rate** to add multiple tax rates within an area.

To add a new tax rate, press the **Add** button. You will be prompted for an Area Id, a description and a percentage for the tax rate in that area. This feature is designed for charging the appropriate tax rate based on the area that a customer resides. You may select the area that the customer is located in the Extended Info tab of Customer Maintenance. When the customer is selected for the invoice, the appropriate tax rate will be charged. This feature is best used in a mail order scenario where you must charge the correct tax when shipping products to a taxable destination.
Change Admin Passwords

You may change the administrator’s password for all stores by pressing the Change Admin Passwords button. PLEASE NOTE: THIS WILL CHANGE THE ADMINISTRATOR’S PASSWORDS FOR ALL STORES.

Pressing Yes will take you to an onscreen keyboard input screen where you may type a new password. Once you press Enter, all stores will be reset to the new administrator password.
Employee Maintenance

The CRE Host module allows you to configure your employees from the corporate office. You may add, edit or even delete employees at the touch of the button.

The Employee Maintenance screen is exactly the same screen within CRE. Please refer to the Employee Maintenance section of this manual for information on configuring your employees. You may also refer to the F1 Help Screen under Managerial Functions and then Employee Maintenance, for more detailed instructions on this feature.

You may also access the Employee Maintenance screen from the File menu of the Log In Screen.
The main function of the monitoring screen is reporting. From this screen you may access a vast number of reports to view the progress of your store or your entire operation. The only button present on the screen is the Reports button. Press this button to access the reporting screen. As you will notice, the reporting screen is practically identical to the reporting screen within CRE. The only difference is that the Host Module adds store ID as another criteria to sort your reports.
Navigating the Reporting Screen

The Reporting Screen allows you to choose various reports and breakdown each report by different criteria. The Category section of the reporting screen allows you to choose from Sales reports, Inventory reports, Customer reports, Employee reports, Restaurant reports and Rental reports.
Once you select a category, the Report window will populate with the appropriate reports for that category. When you highlight a report, some criteria will be activated to indicate that you may breakdown the report by that criteria. In the above illustration, the Invoice Totals report allows you to breakdown the report by Cashier ID, Station ID and Store ID.

To view a report:
1. Select the category for the report you would like to view.
2. Choose the actual report by highlighting it from the Report window.
3. Select the date and time range by entering the Start Date as well as the End Date. Note: The reporting screen always defaults to today’s date between the hours of 12:00:00 AM and 11:59:59 pm. This encompasses the entire day.
4. Choose the criteria you wish to breakdown the report with. You may press the All button to select all criteria. For example, you may wish to show the Invoice Totals report for all Stations and All Cashiers.

The Advanced Reporting feature is a built-in report writing module. For more information or training on report writing, you may contact pcAmerica (1-800-722-6374) for more information.
The **Control function** of the Host Module is where you can add or edit Categories, Vendors, Departments, Purchase Orders, Global Price Changes, Inventory and Groups as well as changing Item Properties. All features present in this screen are also accessible, at the store level, from within CRE via the Options Screen. All screens are identical. The only difference in the Host Module is that you may alter the information in each function for multiple stores.

You may specify which store(s) you wish to change data for by selecting them from the Store Selection box at the top of the screen. When editing any of the functions (Inventory Maintenance, Vendor Maintenance, etc), you will be accessing a master record list corresponding to the function you have selected. The master list encompasses all the records of any store in the entire operation that you have selected. For example, if you select all stores, you will see all items in Inventory for the entire operation. If Store 1003 has an item that the other stores do not have, then that store would have to be highlighted to view the item that is unique to that store. So if 1003 and 1002 are highlighted, you will have all the inventory available to you from stores 1002 and 1003.
Categories are the most general form of categorizing items. You may have inventory items that are part of a department and a department that is part of a category. Generally you have very few categories. For example, you may have a store that has two categories; Clothes and Supplies. If you wish to track retail items, you may create departments under the Clothes category. You may also track supplies, such as hangers, boxes or bags that may fall under the departments in the Supplies category.

To add a category, press the **Add** button. Then enter the Category ID and a Description. Click **Save** to save the category. If you wish to update the category, you may not change the Category ID. You may only change the Description. If you wish to change the ID, you must first delete the category and then re-add it.
Vendor Maintenance is the function that allows you to enter vendor information. Vendors are companies that you purchase products from. In the CRE Host Module, you can control the vendor information for all stores. It is important to enter vendors in for the purpose of Purchase Orders (refer to the Common Retail Functions section for more information). Once vendors are added into the system, you may assign inventory items to a vendor to indicate where you purchase the item. Please refer to the F1 Help Screen on Inventory Maintenance for instructions on how to assign a vendor to an item.

To Add a Vendor, simply press the Add button and fill in the appropriate information. Required fields are the Vendor Number, which is a unique identifying number for the vendor and the Company Name. You may also Edit a Vendor by simply editing the fields you wish to change. The Vendor Number cannot be edited. If you need to change the Vendor Number, you must delete the vendor and re-add it again. **WARNING: IF YOU HAVE INVENTORY ASSIGNED TO THE VENDOR, THEN DELETING THE VENDOR WILL DELETE THE ASSOCIATION OF ITEMS TO THAT VENDOR. YOU WILL HAVE TO RE-ASSIGN THE ITEMS TO THE NEW VENDOR.**
You may enter your departments for your store via Department Maintenance. Select which stores to modify by highlighting the store ID from the Store ID Selection window on the top portion of the Host Module and then press the Department Maintenance button to enter the screen above.

Departments are used to categorize inventory items. For example, in a store, you may specify Janitorial Goods as a department where the items you wish to select for an invoice can be found in that department.

For more information on Department Maintenance, please refer to the F1 Help Screen under Inventory Control and then Department Maintenance.
Global Price Changes

The Global Price change feature allows you to change prices of all or some of your items instantly. Select which store you wish to modify and choose the Global Price Change button to access this screen.

Once inside this screen, you may select to modify All Items, Items in a particular department or a list of selected items. After you select which items to apply the changes to, you may then choose the option you want:

- **Price Change** – This feature will change all the prices for the items you selected to the price you specify. Generally, you do not change the price for All items, so be careful on which selection you have chosen where it says Apply Changes To.

- **X% Price Increase** – This will allow you to increase the item prices for all items you have selected by a fixed percentage amount.

- **Set Sale Price** - This will change the price of an item between a certain date range. Once you specify the price, you will be prompted to enter a start and end date for the sale. Again, it is recommended that you be careful as to what selection you have made where it says Apply Changes To on the left portion of the screen. Normally, you would not have **All Items** selected for this feature.
Host Module – Connecting Multiple Stores

Control

- **Apply X% Discount** – This is virtually the opposite of X% Price Increase. By selecting this feature, you may discount all items selected by a percentage.

- **Quick Help** – This will bring up a quick help screen explaining the Global Price Changes in more detail.

- **Assign Tax** – You may globally assign a tax rate to all items selected.

**Inventory Maintenance**

Using the Host Module, you may add or edit inventory for all stores selected in the Store ID Selection box at the top portion of the screen. The Inventory Maintenance screen within the Host Module is identical to the Inventory Maintenance screen within CRE.

For more information on adding or editing inventory, please refer to the F1 Help screen under Inventory Control. You may also refer to the section on Inventory Maintenance earlier in this manual.

**Item Properties**

For more information on Item Properties, please refer to the F1 Help Section under Inventory Control.

**Styles Matrix**

**Styles Matrix** is a feature designed to be used when you have many variations of the same item, usually with different dimensional attributes. For example, a particular style of clothing may come in different sizes and colors. You may create a group to specify the general style and then specify the dimensions of that style. Then you may easily track the inventory of each variation through an on-screen grid.

This feature is geared more to retail than to hospitality, but can be used in any scenario. For more information on setting up groups (also called styles), please refer to the F1 Help Section under Inventory Control and then Styles Matrix.
The CRE customer base is globally shared throughout your entire operation. When a customer is entered into a store’s register, it will be transmitted to the Host and then back to all the remaining stores. This opens up the ability to share information such as customer account info as well as company wide loyalty incentives and gift cards. For example, a customer may be sold a gift card at one location and they may redeem the gift card at another location. Since CRE has a self contained gift card and loyalty feature built-in, you do not have to incur processing fees from an outside gift and loyalty card processor.

The three features located in the Cooperation Function are **Customer Maintenance**, **Loyalty Plans** and **Loyalty Incentives**.
The **Customer Maintenance** screen in the Host Module is identical to the Customer Maintenance screen within CRE. From the Host Module, you may view, add or edit all customers in the entire operation. Any customer entered at any store will be transmitted to the corporate database and accessible from within the Host Module’s Cooperation function.

For more information on adding or editing customers, you may refer to the F1 Help section under Customer Maintenance. A brief tutorial can be found earlier in this manual in the Tracking Your Customers section.

**Loyalty Plans and Loyalty Incentives**

**Loyalty Plans and Incentives** go hand in hand where a Loyalty Plan is made up of incentives. First, you would set up an incentive and then add the incentive to a plan. The CRE Host Module allows you to add and edit these plans on a corporate wide scale. An example of an incentive might be a free gift when a customer purchases a certain amount from your business. Once the customer reaches a certain dollar amount, the cashier will be prompted to add the free gift to the invoice. In this case, the free gift is the incentive. The customer must be added to the Loyalty Plan in order to receive the incentive. The Loyalty Plan and Loyalty Incentive screens are identical to the screens from within CRE. Please refer to the F1 Help section on Customer Loyalty for more information on creating and adding customers to these loyalty features.
Got a question? We’re here to help.

pcAmerica offers a variety of technical services to help ease your transition, make you comfortable with your new point of sale system and help you with any problems you may have. Contact our sales department to purchase any of our service offerings.

Our **Hourly Training** service is a great way to learn your new point of sale system. A trained engineer will spend a full hour with you on the phone (or over the internet) to walk you through some of our features step by step. They can recommend which features you should use for YOUR business or you can tell them what you’d like to learn. Many business owners also purchase this service after owning the system for many months or years in order to learn new features that they haven’t used yet.

A bundled **technical support and upgrades package** is a must-have for your business. This service is purchased on an annual basis and includes not only your technical support but also all the new versions of Cash Register Express released in that year. On average pcAmerica releases four new versions, each packed with new features.

Need more coverage? pcAmerica offers a **24-7 emergency support contract upgrade** which gives you the highest level of comfort that everything is 100% at your store.

Are you too busy to input your inventory? Our engineers can do it for you with our **Inventory Programming Service**. Send us a copy of your inventory and one of our engineers will input the entire inventory into the system for you.

<table>
<thead>
<tr>
<th>Department</th>
<th>Contact Info</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sales Department</td>
<td>1-800-PC-AMERICA (722-6374) Or 845-920-0800 <a href="mailto:sales@pcamerica.com">sales@pcamerica.com</a></td>
</tr>
<tr>
<td>Technical Support</td>
<td>845-920-0888 <a href="mailto:tech@pcamerica.com">tech@pcamerica.com</a></td>
</tr>
<tr>
<td>Technical Support (AOL Instant Messenger)</td>
<td>Screen names posnow, posnow2 or posnow4</td>
</tr>
</tbody>
</table>

Thank you for choosing pcAmerica!